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1. Purpose and Overview 
This document describes the process by which an Information Provider (IP) can submit Securitisation 
data to the RBA that complies with the RBA’s XML submission data schema (XSD).   

This document specifically relates to and references the following published material: 

a) RMBS,CMBS & OABS XML Schemas (XSD) 
b) RMBS,CMBS & OABS Excel Data Submission Templates 
c) RMBS,CMBS & OABS Example Excel Data Submission Files  
d) RMBS,CMBS & OABS Example XML Outputs; and 
e) Cash Flow Waterfall XML Generation Tool 

A brief overview of the submission validation process 

Each file uploaded to the RBA’s Securitisation System will need to pass various levels of validation 
before the submission is accepted by the Securitisation System.  The file can be manually uploaded via 
the online System or automatically submitted through the B2B API interface. 

The Submission Validation process ascertains that each submitted file meets the following conditions: 

1) XSD Validation – The file must be a valid and properly formed XML file that contains all required 
fields. 

2) Deal and Tranche Registration – The file must refer to a deal that is registered on the 
Securitisation System, and there must be data for each tranche of the deal. 

3) Virus and Malicious code – The file (and in particular, the VBA code for the cash flow waterfall 
(CFW) model) cannot contain any virus or malicious code. 

If the file meets all conditions, the IP receives a Submission Receipt, and the file progresses to 
Submission Data Validation.  Submission Data Validation subjects the data to two general types of tests: 

1) Internal consistency tests — The data within the file must be internally consistent.  For example, 
the Ending Pool Balance must reconcile to the Beginning Pool Balance. 

2) Inter-temporal tests – Certain data within the submission must reconcile to data in previous 
submissions.  For example, the Beginning Pool Balance in the current submission must equal the 
Ending Pool Balance in the preceding submission. 

If the file passes all Submission Data Validation tests, the data in the file updates the database 
maintained by the Securitisation System.  Certain failures of Submission Data Validation tests cause the 
submission to be rejected, while others merely trigger warning messages.  In all cases, whether the file is 
accepted or not, the IP receives a Validation Report detailing all failed tests. 
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2. RMBS, CMBS & OABS Excel Data Submission Templates Usage 
Guide 

In addition to the RMBS, CMBS & OABS XML Schema’s, the RBA has published an RMBS, CMBS & OABS 
Excel Data Submission Templates. These Templates are formatted Excel spreadsheet with the RMBS, 
CMBS or OABS XML Schema (XSD) imbedded. Information Providers can directly enter their submission 
data (except for the CFW model and related data) into the relevant Template and then easily save in the 
required XML format from Excel.  

 IMPORTANT: When creating XML maps and exporting data in Excel to XML files, there is a limit on the 
number of rows that can be exported. Export to XML from Excel will save a maximum of 65536 rows. If 
your file contains more than 65536 rows, Excel will export the first (#ROWS mod 65537) rows. For 
example, if your worksheet has 70000 rows, Excel will export 70000 mod 65537 = 4464 rows.  This is a 
known issue in all office versions up to and including 2010.  

(A separate utility – Cash Flow Waterfall XML Generation Tool – is used to read the CFW Excel file and 
generate an associated XML Data file.) Subsequent versions will be released as necessary in line with the 
XML Schema and RBA reporting requirements.  

1. Download a copy of the RMBS, CMBS or OABS Excel Data Submission Template from the 
Securitisation Industry Forum (SIF) website:  (http://www.rba.gov.au/securitisations/system/support-
material.html) 

 

2. You can rename your downloaded local copy to anything meaningful to you. 

3. You need to create a separate local file per Deal per Reporting Period. 

4. Following the published business guidance notes and descriptions on the SIF website populate all the 
data elements within the file. (http://www.rba.gov.au/securitisations/) 
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Some tips regarding data entry: 

• If you inadvertently add an extra row to an element (for example, an extra Trigger), to reduce 
the size of the XML table, delete the incorrect data row.   

• All fields require some data, either the correct value, or an “ND” code (see Section 6.1 below).   
• XML is very picky when it comes to dates and percentages.  Please remember to do the 

following: 
o For all date fields, format the field as a date value before entering your data.  For 

example, you can set the number format for Loan Maturity Date to be “dd/mm/yyyy” 
before you enter the values.  Once you have done this, Excel will properly convert that 
date to the XML date format (which is always “yyyy-mm-dd”).   

o For all percentages, please enter them as decimal numbers: e.g.   3.5 in place of 3.5%. 

5. Once you have completely populated the data in the workbook, simply select “Save As” from the file 
menu and then select “XML Data” from the file format list.   
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6. To complete your submission file you then need to append the CFW XML Data File. (A utility – Cash 
Flow Waterfall XML Generation Tool – that will read a CFW Excel Model file and generate an associated 
XML Data file is available for download and use on the Securitisation Industry Forum (SIF) website. 
http://www.rba.gov.au/securitisations/system/support-material.html )  

7. Either via the Online Site or B2B API submit the final XML file. 
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3. Cash Flow Waterfall XML Generation Tool Usage Guide 
The RBA has created an Excel based tool (Cash Flow Waterfall XML Generation Tool.xlsm) that can be 
used to generate the CFW node section of the XML Schema. The tool can also be used to merge the 
generated CFW node XML with your XML data file containing the other non-CFW reporting data. It is 
available for download on the Securitisation Industry Forum (SIF) website. 
http://www.rba.gov.au/securitisations/system/support-material.html  

Cash Flow Waterfall XML Generation Tool v1.0.xlsm 

Note: It is possible for an IP to create the XML file using many different technological solutions. (i.e. The 
CFW node section of the XML Schema can be programmatically created without the need to use the Cash 
Flow Waterfall XML Generation Tool)   

 If you decide to build your own utility to package the CFW data, please consider the following points to 
ensure that no elements of the code itself will be misinterpreted by the XML import process. 

• The Securitisation System specifies XML with UTF-8 encoding.  Thus, any code or comments with 
non-UTF-8 characters will be converted to UTF-8.  This is normally not an issue for the VBA code 
itself, but can be for some comments.   
 

• The CFW/Model/VBA_Code_Module/CodeDetails element should be enclosed in <![CDATA[ ]]> 
tags.  For example: 
   <![CDATA[ 
   node details… 
   ]]> 

Subsequent versions of the Cash Flow Waterfall XML Generation Tool will be released as necessary in 
line with the XML Schema and RBA reporting requirements.  

3.1 Minimum Operating Requirements 

3.1.1 Excel Supported Version 
The tool is certified against Excel 2010 and 2013, 32-bit & 64-bit versions. Whilst it’s expected to be 
compatible with more current versions of Excel this hasn’t been tested and can’t be guaranteed. 

3.1.2 Excel References 
The following four libraries are referenced by the Exporter: 

• Visual Basic For Applications 
• Microsoft Excel 14.0 Object Library 
• Microsoft Scripting Runtime 
• Microsoft Visual Basic for Applications Extensibility 5.3 

The Applications Extensibility library is used if you allow programmatic access to the VBA project.  An 
ADODB.Stream object is used for creating the XML file as UTF-8 encoded text; the system uses late 
binding to remove dependency on any specific version of the Microsoft ActiveX Data Objects library. 
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3.1.3 Excel Trust Settings 

The tool requires macros to be enabled and Trust access to VBA project object model to be checked. 

 

3.2 Tool Configuration and Usage Guide 
The Cash Flow Waterfall XML Generation tool is an Excel file that contains a set of VBA macros to 
produce a combined XML submission file for the Securitisation System.   

Key points to note in regards to the CFW Model for the XML Generation tool run: 

a) Make sure that model versioning follows the guidance provided, specifically 
a. for each version of the CFW model, include a worksheet named “Description_i” where i 

is an incremental integer 
b. for each version fo the CFW model, include a VBA code module named 

“WaterfallModel_i” where i is an incremental integer 
b) Make sure that your Variable names(specified in row 31 on the Waterfall worksheet)  are 

unique, and that for each output variable, there is a corresponding Actual field 
c) Make sure that your Data Types (specified in row 32 on the Waterfall worksheet) are either 

“Alphanumeric”, “Numeric”, “Date” or “Boolean”. 
d) Make sure that your Reported Value Type (specified in row 33 on the Waterfall worksheet) is 

one of “AV”, “RV” or “NR” 
e) Always populate the Currency value (specified in row 34 on the Waterfall worksheet) for each 

column.  If no currency is appropriate for the value, please select the appropriate ND5 value. 
f) Always populate the Description fields (specified in row 35 on the Waterfall worksheet) for 

inputs and outputs. 
g) The system reads row 36 and only processes columns that have one of the following values: 

“Input”, “Output”, “Distribution” or “Model Version”. The system checks that each output has a 
unique name; duplicates will cause errors.  In addition, for each Model Output field, the system 
expects to find an Actual Distribution field to match.  Failure to find the output field will cause 
errors. 

h) On the Waterfall worksheet, the system assumes that every row that has a value in column ‘C’, 
from cell ‘C37’ and below, is a valid CFW data series, with each data series corresponding to the 
report date populated in column ‘B’. 

Reserve Bank of Australia   6 



Securitisation System Technical Support Notes 
 

3.2.1 XML Generation Tool Configuration Setup 

 Configuration Block 

 

There are 5 core configuration options (listed above the Deal List section): 

1. Trust Access to VBA Project – this defines how the VBA code is read.  If set to true, the macro 
reads the VBA module from the source CFW Model Excel file itself.  If false, it reads the VBA 
code from a flat file. More detail on this option below. 

2. Show Messages – this controls how verbose the system is.  All messages are also shown in the 
Process Status field. This is intended for debugging when first getting started with the tool or for 
when adding a new deal to the system.  Please be warned that the system can get rather chatty 
if there are many errors in a CFW workbook. 

3. Auto-Archive Folder Structure – if set to anything other than “None” the tool will create date-
stamped copies of the combined XML output files in a time-stamped folder structure.  Options 
are None, Monthly, Quarterly, or Annual. 

4. Output Folder – where should the finished files be created?  The system puts all finished XML 
files into the same output folder. 

5. Temp XML Folder – The system reads the CFW Excel Model file and builds the CFW XML node as 
a discrete file first.  Where should the Exporter save this file?  This needs to be different from 
the Output Folder. 

Per Deal Configurations 

 

For each deal configured on the Exporter, the utility needs to know the following (minimum mandatory 
columns in Red and suffixed with an *: 

1. Deal Name – How would you like the deal to be identified for your purposes? Required field. 
2. CFW File Path – the fully qualified path to the CFW Excel Model file. Required field. 
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3. Submission XML File – Fully qualified path to the deal’s non-CFW data XML file.  If this field is 
blank, the system will produce a flat XML file that contains only the CFW node.  The idea is that 
if your systems are capable of ingesting this information and packaging it into your submission 
file, then the exporter needs to operate in this “simple” mode, too.   

4. Output File Name – How should the combined XML file be named for the deal?  This file will be 
created in the Output Folder and the Auto-Archive folder, too, if using.  Required Field. 

5. Process Status –If no issues, it reports “Success”; if there are errors, they are detailed. 
6. Run Date – When was the deal’s XML submission file last created (or attempted to be created)? 
7. Deal Name, Module Name and Model Code File Path – If “Trust Access to VBA Project” is false, 

you will need to add these details for each model version in your CFW file.  It is imperative that 
the Deal Name specified in column H for each version of the CFW Model matches exactly the 
name in Column A for the deal.  The order if the Code Details Section is independent from the 
order of the Deal List.  The flat file should be in either .txt format (Notepad or equivalent) or .bas 
format, as exported from Excel. 

Please note that the RBA guidance for the CFW Excel Model file states that if ever there are changes to 
the waterfall programme, you will need to provide both an updated programme contained in a new VBA 
code module named WaterfallModel_i (where i is an incremental integer), and an updated description 
of the waterfall in a worksheet titled Description_i (same comment). 

3.2.2 Processing – Batch and Single Deal Modes 

The Exporter has one primary button and this does everything.  To process every deal configured, simply 
select each row using your mouse and then click “Build XML Output Files for Selected Deals.”  The rows 
selected need not be contiguous, and each deal is processed individually. 

 

Notification of Success or Failure for each execution is returned in the Process Status column and last 
run date and time is returned in the Run Date column of the respective Deal. 
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If you get an Excel VBA error and the application appears to be locked or otherwise unresponsive, you 
can either click on the “Reset Excel” button or execute the macro ResetExcel.  View -> Macros -> 
ResetExcel.  If you have a VBA error and hit “Debug” rather than “End” you will need to first exit the VBA 
Editor before resetting Excel.  If this occurs its recommended to close all open Excel sessions on your 
machine and restart. 

 

We have also include within the Tool in the “Possible System Messages” worksheet  a listing of the 
system error and warning messages and their associated functions, processing impact and help 
comments. 

3.3 In-Depth Code Details 
The Cash Flow Waterfall XML Generation Tool makes extensive use of Scripting Dictionaries to store 
data and report to you any issues with it.  If you are unfamiliar with scripting dictionaries, consider them 
to be structured key/value pairs where the value can be another dictionary, creating a recursive 
structure similar to XML itself. 

This section will detail every function in the workbook’s VBA code module. 

3.3.1 Function BuildXMLFiles 

This is the main wrapper function, called when you press the button on the Exporter worksheet.  It 
contains the 3 configuration-centric functions, and then a loop for each of the files it is to process.   

3.3.2 Function LoadConfigs 

Reads the 5 inputs at the top of the worksheet and verifies that the output and Temp XML folders exist.  
If trusted access to VBA module not supported, verifies that  

• There are deal/Module/Module Code Files configured, and 
• That the folders exist – if the folders do not exist, the system will try to create them.  If it is 

unable to do so, the system will halt here. 

Please note that this step does not verify that settings are correct for the selected deals. 

3.3.3 Function LoadToProcessHash 

This reads the settings for the selected deals – not for everything, but only for the selected deals. 
Specifically, it checks that 
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• CFW File exists 
• If there is anything specified in the submission XML file, that this file exists.  If the submission 

XML file entry is blank, then it simply generates an XML file for the CFW node alone. 
• If trusted access to the VBA Project is not granted, this step verifies that one or more code 

modules are specified (as per the LoadConfigs function) 

3.3.4 Function SetArchiveFolder 

This simple utility verifies that the auto-archive folder structure is correctly set and, if so configured, 
tries to create required folders.  If the system is unable to create a required folder, it will notify you of 
this and proceed to generate the requested XML file(s) as though Auto Archive Folder Structure was 
“None.” 

3.3.5 Function BuildXMLfromCFWWorkbook 

This function does all of the heavy lifting of the programme.  There are 6 steps required to build the 
Submission XML file: 

1) Verify the structure of the CFW file 
2) Collect the VBA from the file or from exported file(s). 
3) Collect the Description(s) 
4) Collect the Waterfall data 
5) Build the temporary CFW XML file 
6) Merge that file into the submission file 

Between each of the above steps, if there are any errors detected by the system, it will stop processing 
and report on the error(s) detected.  

Please note that if the system finds errors in your file it will leave it open in Excel, but if there are no 
errors, it will close the workbook without saving the file.  Please save your important work before 
running the exporter. 

3.3.6 Function Step1VerifyCFWFile 

There are two variants of this function, depending on whether you trust access to the VBA project or 
not.   The core purpose of the file is to check that for each and every version of the waterfall, there is 
both a VBA code module named “WaterfallModel_i” and a description worksheet named 
“Description_i”.  Any worksheets or code modules that come close to the naming convention but don’t 
quite make it will cause errors.   

3.3.7 Function Step2GetVBAFromFile 

As above, there are two variants of this function. This reads the VBA code into memory as strings either 
from the VBA Project itself, or from the VBA module export files configured in columns H, I and J.  

3.3.8 Function Step3CollectCFWDescriptions 

This function populates the Description nodes for each of the CFW model versions.  This also checks that 
for each version, there is a description and a VBA code module.   
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3.3.9 Function Step4ProcessWaterfall 

This function will prove problematic if you did not heed the advice given in section Preventing Errors in 
the CFW files on page 5.  Specific things the function checks for include: 

• Row 32 has values that are either “Alphanumeric”, “Numeric”, “Date” or “Boolean” 
• Row 33 has values that are either “AV”, “RV” or “NR 
• Every Distribution field matches an Output field 
• Every Output field is matched to a Distribution field 
• The CFW_Program is specified for every time series 

Failure to comply with these requirements will cause the system to stop processing at this step. 

3.3.10 Function Step5ProduceCFWXMLOutput 

The system creates an XML file containing just the CFW XML data.  Aside from not being able to write 
the file to the specified folder, there is little that will break this function. 

3.3.11 Function Step6MergeCFWXMLIntoMainSubmissionFile 

The code is looking for the </Deal> string somewhere in the submission XML file.  This indicates the end 
of the Deal node, and is a suitable place for the CFW node to be inserted.  

3.3.12 Utility Functions 

There are several minor functions in the utility that serve a few purposes: 

• RecordError – any time the system detects an error, this function executes 5 lines of code 
• CollectGarbage – at the end of processing, this function clears items from memory 
• OpenFileWrapper – a utility to open excel files; calls OpenWorkbook if needed 
• CheckFolderPath – verifies that a folder exists, and if it does not, tries to create it 
• LockExcel and UnlockExcel – controls the application itself; suppresses/enables screen updating, 

automatic calculation mode, and enable events, three settings that can have a large impact on 
the performance of the platform 

• ResetExcel – this subroutine calls UnlockExcel and is visible from the Macro panel.  You will 
want to run this if the VBA generates an error and stops running.  This puts the application back 
in a more responsive mode as described above. 

• RemoveDuplicateSpaces – a very small utility to remove duplicate spaces from a string; used to 
consolidate CFW VBA code lines that span more than one line in the Code module 
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4. Potential End to End Workflow Guide 
The picture below shows a potential workflow for an individual RMBS deal (equally applies to the CMBS 
or OABS deals also using their respective submission templates): 

 

 

 

 

 

 

 

 

 

1. The RMBS Example Excel Data Submission File contains all of the data for a submission (except 
for the CFW model and related data) in an Excel file that has been mapped to the RMBS XML 
Schema (XSD) for the Securitisation System. Download a copy from the Securitisation Industry 
Forum website: http://www.rba.gov.au/securitisations/system/support-material.html 
 

 
 

2. Saving the Excel Data File through Excel as an XML data file, produces the RMBS Example XML 
Output Data File.   
Note: This is listed as a separate file because it is possible for an IP to create the XML file using 
many different technological solutions. (i.e. The RMBS XML Output Data File can be 
programmatically created directly from your core data sources without the need to use Step 1)   

RMBS Excel Data Submission Template 
(RMBS Example Excel Data Submission File) 

RMBS XML Output Data File 
(RMBS Example XML Output) 

Excel CFW File 

Cash Flow Waterfall XML Generation Tool 

RMBS XML Submission File 
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3. The Excel CFW File contains the CFW Model written in VBA and related data in compliance with 
the RBA guidance on the Securitisation Industry Forum website: 
http://www.rba.gov.au/securitisations/ 
 

 
 

4. The Cash Flow Waterfall XML Generation Tool is a utility which generates a CFW XML Output 
Data file from the Excel CFW file and optionally appends it to the RMBS XML Output Data File 
created in step 2, creating the  
Note: It is possible for an IP to create the XML file using many different technological solutions. 
(i.e. The CFW XML node section of the XML Schema can be programmatically created without 
the need to use the Cash Flow Waterfall XML Generation Tool)   
 

5. RMBS XML Submission File – a complete set of data required for each deal. 

Please note that each RMBS XML Output Data File and Excel CFW file will need to be produced / 
maintained by the IP separately.   
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5. XML Overview 
Extensible Markup Language (XML) can be thought of as a framework through which to define data 
structures and relationships.  The intention of this document is not to be an exhaustive resource for XML 
definitions; for that purpose, a good place to begin is http://www.w3.org, the World Wide Web 
consortium. 

The XSD defines the relationships between these elements and the rules by which an XML file is 
validated for conformity with the schema. 

Each data element has a type and value.  The type can be either simple or complex.  An example of a 
simple data type is a date, or a string.  A complex data type is a grouping of more than one simple 
element, for example a company reference in an XSD could contain a name and an ABN.  Data 
references can be grouped and nested to define truly complex elements.   

For example, in a simple XSD we have the following definition for a company: 

 

This element can be included by reference in another element, for example, a counter party: 

 

The resultant XML for a counter party looks like this: 

 

For more information on XML and XML schemas please visit http://www.w3.org/standards/xml/ 

 

 

  

<xs:complexType name="Company"> 
  <xs:sequence> 
   <xs:element name="name" type="xs:string"/> 
   <xs:element name="ABN" type="xs:long"/> 
  </xs:sequence> 
 </xs:complexType> 
 

<xs:complexType name="Counter_Party"> 
  <xs:sequence> 
   <xs:element name="Role" type="xs:string" /> 
   <xs:element name="Company" type="Company" /> 
  </xs:sequence> 
 </xs:complexType> 
 

<Counter_Party> 
 <Role>AUD/USD Swap Counter Party</Role> 
 <Company> 
  <name>Random Bank</name> 
  <ABN>321654897</ABN> 
 </Company> 
</ Counter_Party > 
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6. XML Schema Definition - XSD 
This section discusses the key elements of the RMBS XML Schema (XSD), available on the Securitisation 
Industry Forum website:  

http://www.rba.gov.au/securitisations/system/support-material.html 

 

The XSD can be divided into three main sections: 

a) The Submission node, which details all of the required elements and enforces the referential 
integrity (discussed more below), 

b) Simple Type Definitions, and  
c) Complex Type Definitions. 

We will focus on simple data types (as related to individual fields) first, and then discuss the Deal node 
itself in more detail. 

There are numerous references in the XSD to data types, and it is important to note that XSD validation 
is very strict about this.   

NOTE: when exporting data from Excel, the value from the cell will be exported, not the value shown.  
Edit the value only. 

6.1 Data Type Details 
The following section details all of the simple data types found in the XSD.  Complex data elements are 
comprised of combinations of these elements.   

Dec – Decimal numbers.  The only thing to note is that there are 9 decimal places only.  Extra precision 
will break XSD validation.  Excel format = “0.0########” 

Int – Integer numbers.  Excel format = “0”.  The limits for an integer value are +/- 2147483647. 
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Money – positive or negative numbers with only 2 decimal places. Excel format = “0.00” 

Currency – a 3-character string for the currency.  For example, “AUD”, or “NZD”.  

Date – a valid date value.  Please note that XML is very particular about dates.  When entering your 
dates, you must format the required range of cells as a date prior to export.  Excel will transpose the 
date value into the XML-date format, which is always “yyyy-mm-dd”.   

String100, String250 – strings limited to this specific length.   

NoDataCode –This case insensitive string (i.e., “nd1” or ND1” are both valid) tells the system why a 
required field is otherwise blank.  The six accepted ND values are: 

• ND1 – Data not collected 
• ND2 – Data collected but not loaded into the reporting system at completion 
• ND3 – Data collected but loaded into a separate system from the reporting one 
• ND4 YYYY-MM – Data collected shall only be available from the specified future date 
• ND5 – Field not applicable – N/A 
• ND6 – Pending sale (to be used for [Loss on Sale (loan related data field)] only) 

ND4Dec – either a valid Dec value, or a valid NoDataCode value. 

ND4Int – either a valid Int value, or a valid NoDataCode value. 

ND4Currency – either a valid Currency string, or a valid NoDataCode value. 

ND4Money – either a valid Money value, or a valid NoDataCode value. 

ND4String4 – either a 4-character string value, or a valid NoDataCode value.  This is used for specifying 
either Governing Law or ratings values. 

ND4String, ND4String100, ND4String250 – either a valid string limited to the appropriate length, or a 
valid NoDataCode value. 

ND4Date – either a valid Date value or a valid NoDataCode value. 

ND4Bool – either a valid XML boolean value or a valid NoDataCode value. 

ND4Long – either a valid XML long value or a valid NoDataCode value.  The limits for an XML long value 
are +/- 9223372036854775807. 

CFWValueType – an enumerated list of valid input types in line with the guidance provided on the CFW 
workbook.  Acceptable values are one of “Numeric”, “Alphanumeric”, “Date” or “Boolean”.   

CFWDataType – an enumerated list of valid data types for the CFW inputs and outputs. Acceptable 
value include “AV” (actual value), “RV” (redacted value), and “NR” (not reported). 

Please review the XSD carefully. 

 

Reserve Bank of Australia   16 



Securitisation System Technical Support Notes 
 

6.2 Deal Data 
Key elements to note regarding some elements of the Deal data type: 

• One limitation of Excel’s XML support is its inability to handle recursive structures.  This has 
forced us to break elements of the XSD into sub-nodes.  For example, the submission node 
includes one or more tranches, which are represented by rows in the RMBS Excel Data 
Submission Template.  For each tranche, however, there can be zero or more ratings, and zero 
or more exchanges associated.  This means that we have dedicated tables for ratings, exchange 
listings and clearing systems.   
Referential integrity is enforced through the XSD, so please pay particular attention to account 
and tranche names in the sections detailed, below.  The full list of these relationships are: 

o Account_Provider -> Signature_Authority (linked by Account_Name) 
o Tranche -> Rating (linked by Tranche_Name) 
o Tranche -> Clearing_System (linked by Tranche_Name) 
o Tranche -> Exchange_Listing (linked by Tranche_Name) 

 
• The Nameblock is a feature of the XSD that appears several times.  It is intended to be 

shorthand for all of the fields required by the RBA to identify a party to the transaction.  The 
Nameblock has five (5) sub-elements: 

o Name – the name of the company/entity 
o ABN – when applicable, the ABN of the firm 
o ID – if an ABN is not available, the identifier used to specify the company 
o ID_Descriptor – if an ABN is not available describes the type of reference in the ID field.  

For example, if the ID for Moody’s is “336969”, the ID Descriptor that corresponds to 
this code is “Australian Financial Services License No.”. 

o Jurisdiction - if an ABN is not available 
• Some elements are listed with a minOccurs variable set to zero (0) to accommodate scenarios 

where these elements are not required.  
o Clearing_System, Exchange System and Rating – not every tranche will have its bonds 

listed somewhere (or cleared, or rated); we want to be flexible to accommodate the 
situation when this does not apply. 

o Loan_Level, Trigger, LMI_Provider, Account_Provider, Signature_Authority, 
Authority_Holder, Liquidity_Provider, Credit_Enhancement_Provider, 
Swap_or_Hedge_Provider 

o CFW – if the submission is a revision, you are not required to provide a revised CFW 
node.  But for regular submissions, a failure to submit a CFW node will cause the 
submission to fail XML validation. 

• Several elements are expected to be broken out by currency, as appropriate.  Specifically: 
o Originator, Seller and LMI_Provider  – for each currency and Originator/Seller LMI 

provider pair, you need to provide details on the Settlement Date Loans Originated and 
current Loans Originated (or sold, or insured). To be clear, if Originator A originated 
loans in the pool in both AUD and NZD, the submission should include two entries for 
Originator A’s Settlement Date Loans Originated, one for each currency. 

o Pool_Rollups – all statistics will need to be provided for each currency in the pool.  
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7. The RMBS, CMBS & OABS Excel Data Submission Templates 
This section of the document will show you how we created the RMBS, CMBS & OABS Excel Data 
Submission Templates.  Once the data is properly mapped, all you will need to do to create your XML 
submission file is Save As and select XML Data from the dropdown list.   

7.1 Adding the Developer Ribbon to Excel 
Excel provides a helpful utility for managing XML mappings, but you will need the Developer tab to be 
present to use.  If your Ribbon does not have the Developer tab, it will appear (more or less) like this: 

 

 

To add the Developer tab, select File -> Options -> Customize Ribbon, and then click on Developer as 
shown below. 

 

Click OK, and the Developer ribbon will be shown on your Excel. 
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7.2 Associating the XSD with the File 
On the Developer tab, select Source.   

 

This will bring up a side-bar that shows the XML maps (schemas) present in the workbook.  Click on XML 
Maps, then Add, Select your Schema file, and click OK.  The Source pane will now show a hierarchy of 
the elements in the XSD. 
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7.3 Mapping Elements of the XSD to the File 
One way to map the elements to the XSD is to drag and drop the fields onto the worksheet where you 
would like to see them.  This approach needs to be carefully applied.  This is the recommended order to 
add the fields: 

1) Compress the schema’s tree structure so that only the “Deal” node (the only node under 
“Submission”) is expanded. 
 

2) De-select all compressed fields (i.e., Sponsor, Trigger, Role, etc.): 

Picture for step 1:  Picture for step 2:  
 

3) Drag the Deal node to cell A3 (I have added text in A1) and release. 
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4) Click on the blue Header Options icon after the far right cell, and select Place XML Heading 
Above.  Your workbook will now look like this: 

 
5) Repeat with the Sponsor node (the only other node you need to add to the workbook which will 

not automatically insert the headers.    
6) Click on the compressed Trigger node in the XML Source map, and drag that to a place on the 

workbook.  Excel will automatically add the headers because the schema understands that there 
can be more than one trigger on a deal. 

 
7) Repeat this process for all other elements in the XML Source except the CFW node. The CFW 

node is different because it uses a more complex recursive structure that is not supported by 
Excel’s XML mapping utilities 

8) Please note that in the RMBS Excel Data Submission Template and the RMBS Example Excel Data 
Submission File we showed the Loan Level node on a separate worksheet.  Where you store the 
Loan Level data (if submitting it) is entirely up to you.  If you want to put everything in one 
worksheet, you can do that, no problem. 

9) In addition, note that in the RMBS Excel Data Submission Template and the RMBS Example Excel 
Data Submission File distributed with this document, the headings for the Deal Top Level and 
Sponsor sections were formatted for clarity.  What was shown above are what Excel produces 
by default.   

7.4 Additional Points to Note on the RMBS Excel Data Submission Template 
There are few points to note regarding mapping elements to the Excel workbook: 

• Once you have completely populated the data for the workbook, simply select “Save As” from 
the file menu and then select “XML Data” from the file format list.   

• At the bottom of the XML source window there is a link to “Verify Map for Export…” – this will 
almost always say that “The schema contains required elements which have not been mapped 
onto the spreadsheet.”  Excel wants to see absolutely everything mapped, but the CFW node is 
processed differently. 

• The Exporter Utility, Cash Flow Waterfall XML Generation Tool, takes the CFW workbook for 
your CFW model and related data and packages it appropriately into XML following the XSD. 
Download a copy from the Securitisation Industry Forum website: 
http://www.rba.gov.au/securitisations/system/support-material.html#technical-
implementation-support-notes  
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• If you inadvertently add an extra row to an element (for example, an extra Trigger), to reduce 
the size of the XML table, click on the lower-right corner of the table and move it up towards the 
header the required amount.   

• All fields require some data, either the correct value, or an “ND” code, described above.   
• XML is very picky when it comes to dates and percentages.  Please remember to do the 

following: 
o For all date fields, format the field as a date value before entering your data.  For 

example, you can set the number format for Loan Maturity Date to be “dd/mm/yyyy” 
before you enter the values.  Once you have done this, Excel will properly convert that 
date to the XML date format (which is always “yyyy-mm-dd”).   

o For all percentages, please enter them as decimal numbers 3.5 in place of 3.5%. 
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8. Appendix A: Document Control  
 

Version Date Details 

1.7 28 April 2015 Included reference in section 7.4 to the Securitisation Industry 
Forum website to access the Cash Flow Waterfall XML 
Generation Tool. 

1.6 5 March 2015 Clarified advice around input values for Row 32 in the Shell Excel 
File for the Cash Flow Waterfall Template, a possible input value 
is “numeric”, not “numbers” in section 3.3.9.  

1.5 8 December 2014 Clarified that percentages should be reported as decimals (i.e. 
3.5% is reported as 3.5).  

1.4 1 October 2014 Updated the document to include CMBS and OABS.  

1.3 29 August 2014 Added “ND4String” as a data type to cater for String(MAX) 
characters; added clarification section 6.2, changed minOccurs 
setting to 0 for the Account_Provider, Signature_Authority, 
Trigger, LMI_Provider, Authority_Holder, 
Liquidity_Provider, Credit_Enhancement_Provider and 
Swap_or_Hedge_Provider XML definitions in the Deal node. 

1.2 16 August 2014 Confirmed the Excel supported versions for the Cash Flow 
Waterfall XML Generation Tool. 

1.1 15 August 2014 Added guidance for the Cash Flow Waterfall XML Generation 
Tool (Section 3).  

1.0 31 July 2014 The Securitisation System Technical Support Notes 
(version 1.0) published. 

 

Reserve Bank of Australia   23 


	1. Purpose and Overview
	2. RMBS, CMBS & OABS Excel Data Submission Templates Usage Guide
	3. Cash Flow Waterfall XML Generation Tool Usage Guide
	3.1 Minimum Operating Requirements
	3.1.1 Excel Supported Version
	3.1.2 Excel References
	3.1.3 Excel Trust Settings

	3.2 Tool Configuration and Usage Guide
	3.2.1 XML Generation Tool Configuration Setup
	Configuration Block
	Per Deal Configurations

	3.2.2 Processing – Batch and Single Deal Modes

	3.3 In-Depth Code Details
	3.3.1 Function BuildXMLFiles
	3.3.2 Function LoadConfigs
	3.3.3 Function LoadToProcessHash
	3.3.4 Function SetArchiveFolder
	3.3.5 Function BuildXMLfromCFWWorkbook
	3.3.6 Function Step1VerifyCFWFile
	3.3.7 Function Step2GetVBAFromFile
	3.3.8 Function Step3CollectCFWDescriptions
	3.3.9 Function Step4ProcessWaterfall
	3.3.10 Function Step5ProduceCFWXMLOutput
	3.3.11 Function Step6MergeCFWXMLIntoMainSubmissionFile
	3.3.12 Utility Functions


	4. Potential End to End Workflow Guide
	5. XML Overview
	6. XML Schema Definition - XSD
	6.1 Data Type Details
	6.2 Deal Data

	7. The RMBS, CMBS & OABS Excel Data Submission Templates
	7.1 Adding the Developer Ribbon to Excel
	7.2 Associating the XSD with the File
	7.3 Mapping Elements of the XSD to the File
	7.4 Additional Points to Note on the RMBS Excel Data Submission Template

	8. Appendix A: Document Control

